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Was ist JORGE?

JORGE ist eine 3D Simulation fiir LEGO Mindstorms Roboter. Wie beim Vorbild aus der realen Welt,
kann man ein Programm auf einen (virtuellen) Roboter laden, das Programm starten und das Verhal-
ten des Roboters beobachten. Zur Darstellung des Roboters und der ihn umgebenden Landschaft nutzt
JORGE eine dreidimensionale Ansicht, wie man es von aktuellen Spielen kennt. Der grosste Vorteil der
Simulation besteht in der Nachbildung von physikalischen Eigenschaften: JORGE bietet zum Beispiel die
Moglichkeit an, die Gravitation der virtuellen Welt zu verandern oder die Kraft der Motoren zu erhéhen.

Zum einen dient dieses Dokument zur kurzen Einfiihrung und Erkldrung der wichtigsten Funktionen
von JORGE. Zum anderen richtet es sich an Anwender die interessiert sind, Roboter Programme in Java
zu schreiben und sie zu testen. Es setzt voraus, dass JORGE erfolgreich installiert wurde. Hierzu stellen
wir eine ausfiihrliche Installationsanleitung zur Verfligung.
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Kapitel 1

Erste Schritte

In diesem Kapitel wird Schritt fiir Schritt erkléart, wie Sie Hindernisse und Roboter in die virtuelle Welt
einfiigen kénnen. Im zweiten Teil wird ein Roboter-Programme erstellt und auf dem virtuellen Roboter
ausgefiihrt.

1.1 Der Aufruf von JORGE

Wie unter Windows iiblich, kann JORGE bequem iiber den entsprechenden Eintrag im Start-Menii gest-
artet werden. Wenn Sie bereits eine JORGE-Projektdatei haben, wird JORGE ausgefiihrt wenn Sie diese
Datei 6flnen (Doppelklick).

Settings

Render Settings

Rendering Subsystem: Direct3D9 Rendring SubSystem -

anti aliasing: Hone

Floating-poink mode: Fastest

Full Screen: Mo

Rendering Device: NYIDIA Quadro FX 3400
wSyne: o

wideo Mode: 1260 1024 @ 16-hit colaur

[hoose An Option]: [
Environment Settings
These Settings are used by ths compiler of the Source Code Edtar.
Java-Compler (e.q. javac.exel:
Ledos-Directoryi
Loaded Sensor Plugins

Name Version | _Description Author
[ight Touch Sensor 0.1 A Touch Sensor  JORGE Team
Compass Sensor 0.1 A Compass Sensor | JORGE Team
Left Touch Sensor 0.1 A Touch Sensor JORGE Team

Cancel

Abbildung 1.1: Einstellungen

Wenn Sie JORGE das erste Mal starten erscheint der obige Dialog, damit konnen Sie die wichtigsten
Einstellungen vornehmen:

e Render Settings: Hier konnten Sie das Darstellungssystem fiir 3D auswéhlen. OpenGL und
Direct3D7 werden leider nicht unterstiitzt.

e Environment Settings: Um Programme mit dem in JORGE eingebauten Editor (dazu spéter mehr)
zu schreiben, muss angegeben werden, wo das Programm javac.exe zu finden ist, und wo Sie LeJOS
installiert haben. Klicken Sie auf die Schaltfliche Choose, um die Einstellungen vorzunehmen. Ein
Beispiel:
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— Java-Compiler: C:\j2sdk1.4.2 09\bin\javac.exe

— LeJos-Directory: C:\java\lejos\
Eine kurze Anleitung zur Installation von LeJOS und Java finden Sie im Anhang A bzw. B.
e Loaded Sensor Plugins: Hier wird lediglich angezeigt, welche Sensoren geladen wurden.

Nachdem Sie alle Einstellungen vorgenommen haben, kénnen Sie die Konfiguration mit OK abschliessen.

1.2 JORGE gestartet - Was nun?

Nun zeigt JORGE ein leeres Fenster mit deaktivierten Schaltflichen an. Dies liegt daran, dass Sie noch

— JORGE - Control =Jo&d

Eile Robot Simulation  Help

Mew Simulation (
Cpen Simulation... A

-

2]

a
A

%, Settings...

() Exit

Abbildung 1.2: Haupt Fenster

keine Simulation erstellt bzw. geéffnet haben. Eine Simulation kénnen Sie mit einem Dokument in einem
Textverarbeitungsprogramm vergleichen: In einer Simulation werden sdmtliche Einstellungen gespeichert.
Dies ermoglicht es Thnen, eine Simulation vorzubereiten und verschiedene Roboterprogramme mit genau
gleichen Voraussetzungen zu testen.

Wahlen Sie, wie in der Abbildung 1.2 abgebildet, die Funktion File> New Simulation, um eine neue
Simulation anzulegen. Im Abschnitt 2.2 wird auf den nun angezeigten Dialog, in dem es darum geht die
Welt auszuwéhlen und die Gravitation fiir diese Welt festzulegen, genauer eingegangen. Wéhlen Sie Done,
um mit den Standardeinstellungen fortzufahren.

1.3 Hauptfenster - Welt Konfigurations Modus

Jetzt wird eine neue Simulation angelegt, und die Benutzeroberflache verdndert ihr Aussehen: Sie befinden
sich nun im “Welt Konfigrations Modus”. In diesem Modus geht es darum, Roboter und Hindernisse in
der Landschaft zu platzieren.
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1 JORGE - Control EoE
File Robot Simulation Help I
o= 6 G

Abbildung 1.3: Hauptfenster

Auf die einzelnen Bestandteile der Benutzeroberfliche wird im Abschnitt 2.1 genauer eingegangen. Sie
kénnen nun zu einer virtuellen Erkundungsreise aufbrechen und sich die Welt ansehen. Die Navigation
erfolgt mit Maus und Tastatur:

e Mit der Maus verédndern Sie die Blickrichtung.

e Mit den Pfeiltasten der Tastatur konnen Sie die Kamera in die entsprechende Richtung verschieben.
Die Tasten Page Up und Page Down bewegen die Kamera horizontal.

e Mit der Taste Q, kénnen Sie den Anzeige-Modus verdndern:

1. Standard Ansicht: Die Landschaft wird mit allen Details angezeigt.
2. Gitternetz Ansicht: Die Oberfliche wird nur mit Linienansicht dargestellt.
3. Punkte Ansicht: Die Oberfliche wird nur durch Punkte reprasentiert.

1.3.1 Hindernisse Einfiigen

Wenn Sie mit der Maus im unteren Bereich des Fensters auf den Fussball klicken, wird ein Fussball in die
Simulation eingefiigt. Das rote Kreuz in der Mitte zeigt an wo genau das gewahlte Hindernis eingefiigt
wird.

Mit Hindernissen kénnen Sie einen Parcours fiir Ihre Roboter gestalten. Im Abschnitt 3.1 wird erklért
wie Sie selber hergestellte Hindernisse hinzufiigen kénnen.

1.3.2 Roboter Einfiigen

Die Roboter sind der wichtigste Teil der Simulation. Uber das Menii Robot > Add Robot wird ein neuer
Roboter in die Simulation eingefiigt. Alternativ kénnen Sie auch das griine Kreuz in der Toolbar zum
Einfiigen von Robotern benutzen.

Wie die Hindernisse, werden auch Roboter an der Stelle eingefiigt, wo das rote Kreuz angezeigt wird.
Die Abbildung 1.4 zeigt JORGE nachdem ein Roboter eingefiigt wurde. Fiir jeden eingefiigten Roboter
wird auf der linken Seite ein Reiter erstellt, RobotTab genannt. Uber Thn kénnen alle Einstellungen die
einen Roboter betreffen, vorgenommen werden. Der Roboter, der zum aktuellen RobotTab gehort, wird
durch einen roten Kreis markiert.
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1 JORGE - Control M=)
File Robet Simulation Help

= LG
] . IR ~
Robat: 1139485309 |

Rabot Control

Current Position:

% | 2228275391 | z; | 2s12.970459

Replace Rebot] 5o

LCD Dutput

Vi 1

=

A

Emulation ‘

Robot Details
Robot Name: Robat: 1134486309

Frogram Binary: |

Robok Colour: cha

Robat Settings Edit Program Source

Robot Log

&

Abbildung 1.4: JORGE mit einem Roboter

1.4 Ein bestehendes Programm Laden

Ein LeJOS Programm kann iiber die Schaltfliche Load auf dem RobotTab ausgewéhlt werden. Sobald das
Programm geladen ist, wird dieses innerhalb des RobotTabs im Textfeld Robot Log angezeigt. Wenn Sie
JORGE nur testen wollen, kénnen Sie Beispielprogramme laden, welche Sie unter <JORGE Installations-
Ordner>/lejos/ finden. Wie man eigenen Programme schreiben und laden kann, wird im néchsten Kapitel
beschrieben.

1.5 Editor - Ein Programm erstellen

1.5.1 Programm Erstellen

Wihlen Sie nun Edit Program Source: Ein Fenster mit dem Namen Source Code Editor wird gedffnet.
Wahlen Sie die Aktion File>New... um eine neue Datei zu erstellen. Jetzt muss ein Verzeichnis und ein
Dateiname fiir die neue Datei angegeben werden. Fiir dieses Beispiel wihlen wir den Dateinamen Hello-
Robot.java. Bevor Sie nun mit dem Schreiben des Programms beginnen kénnen, miissen Sie eine weitere
Frage von JORGE beantworten: Soll die Datei die Sie eben erstellt haben, ins Projekt aufgenommen
werden? Wenn Sie die Frage mit Ja beantworten, wird das néchste Mal, wenn Sie auf die Schaltflache
Edit Program Source klicken, die Datei HelloRobot.java geoffnet. Wenn Sie dies nicht m6chten, antworten
Sie mit Nein.

Sie kénnen nun die folgenden Zeilen Quelltext in den Editor kopieren oder selber ein Programm
schreiben. Wenn Sie mehr Informationen zu den eingesetzten Funktionen erhalten mochten, kénnen Sie
in der Toolbar auf die Schaltfliche Open LeJos Api driicken (in ihrem Browser wird dann die LeJOS
Dokumentation geoéffnet).

import josx.platform.rcx.*;
public class HelloRobot
{
public static void main(String args[]) throws Exception
{
Motor.A.forward();
Motor.C.forward() ;
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Thread.sleep(2000);

Motor.C.stop();
Thread.sleep(2000);
Motor.C.stop();
Motor.A.stop();

Motor.A.backward();
Motor.C.forward();
Thread.sleep(6000);

Motor.A.stop();
Motor.C.stop();

1.5.2 Das Programm Kompilieren, Linken und Laden

—ISource Code Editor g @
Eie Edit View Extra Window Help

o« =] N Y

Compile Link Upload Open Lelos Api
HeloRabot

public class HelloRobot [al|
I}

public static void main{String args[]) threws Exception

~ {

Mocor.A.forward();
Motor.C.forvard{) ;
Thread.sleep(z000) ;

Motor.C.stop()
Thread.sleep(2000) ;

Motor.C.stop() ;
Motor.h.ztop()

Motor.d.backward() :
Motor.C.forward() ;

Motor.k.stop();
Motor.C.stop()
}
¥

<[ I i

Setting Environmet: JAVAC=C:\JjZsdkl.4.2 09\bin\javac.exe
getting Environmet: LEJOS HOME=D:\lejos

Compile Command: D:%lejos\bin\lejosc.exre -target 1.1 C:\javal\He
C:\java\HelleRobot. java:16: ;' expected

~

1l error
== Dong ==

& l B

Abbildung 1.5: Kompilieren

Abbildung 1.5 zeigt den Editor, nachdem die Aktion Compile ausgefiihrt wurde. Im unteren Teil ist die
Ausgabe des Compilers zu sehen, der einen Fehler beim kompilieren festgestellt hat. Wenn der Compiler
keine Fehler beanstandet, kann das Programm mit der Aktion Link gelinkt werden, und wenn auch diese
Aktion erfolgreich ist, kann das Programm mit der Schaltfliche Upload auf den Roboter iibertragen
werden.

1.6 Hauptfenster - Roboter Ansehen Modus

Eigentlich ist nun alles bereit um die Simulation und somit das Programm zu starten. Der zweite Modus
ermoglicht es Thnen, den Roboter von allen Seiten anzusehen und die Farbe zu verdndern. Um in diesen
Modus zu wechseln, konnen Sie die Aktion Robot > View Robot im Menii auslésen oder das entsprechende
Symbol in der Toolbar wahlen. Die Abbildung 1.6 zeigt, den Roboter nachdem die Farbe verdndert wurde.
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1 JORGE - Control =% )

Ele Robot Simdation Help

+= {RAG

Robot: 1134494628 |

Robot Control

Current Position:
w | 2637421875 | 7, | zze9.101583

LCD Output
Vizw 4 o 3 Pram

Oonoff Run
A B C
Emulation
Robot Details
Robot Mame: Robot: 1134494628
e

Robot Settings | [ Edit Program Sourcs |

Abbildung 1.6: Roboter Ansehen

In diesem Modus sind folgende Aktionen moglich:

e Mit den Pfeilen der Tastatur kann der Roboter in jede Richtung gedreht werden.

1.7 Hauptfenster - Simulations Modus

Nachdem Sie vom Roboter Ansehen Modus zuriick in den Welt Konfigurieren Modus gewechselt haben
(Menu Simulation > Prepare Simulation), kann die Simulation nun gestartet werden:

Lésen Sie dazu die Aktion Simulation > Start Simulation aus. Sobald der Simulations Modus aktiviert
ist, werden alle Roboter bzw. dessen Programme gestartet. Im Robot Log werden alle Instruktionen, mit
denen das Programm den virtuellen Roboter steuert, gezeigt. Beim Beispiel aus dem Abschnitt 1.5.1 wird
folgendes Ausgegeben:

Reading binary: C:\java\HelloRobot.emu
Installing binary 80240944

Checking validity of magic number
Engine starting.

Set Motor O Forward

Set Motor 2 Forward
Set Motor 2 Brake
Set Motor 2 Brake
Set Motor O Brake
Set Motor O Backward
Set Motor 2 Forward
Set Motor O Brake

Set Motor 2 Brake

Reading binary: C:\java\HelloRobot.emu
Installing binary 80140032

Checking validity of magic number
Engine finished.

Das Programm kann nun beliebig oft iiber das RobotTab gestartet, pausiert oder beendet werden. Wenn
Sie das Programm nun verdndern mochten, konnen Sie dies tun, indem Sie zuriick in den Welt Konfigu-
rieren Modus wechseln (Menii Simulation > Prepare Simulation).
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Kapitel 2

Uberblick

In diesem Kapitel werden alle Komponenten der Benutzeroberfliche vorgestellt und erkléart.

2.1 Das Hauptfenster

Toolbar

- Overlay
2

RoboTab

A =

Ogre Window

[Robot Log

Emulator Output

o™

ObstacleToolbar

Abbildung 2.1: Hauptfenster Ubersicht

Die obige Abbildung zeigt alle Komponenten die in den folgenden Abschnitten erldutert werden.

2.1.1 Meniileiste

Jedes Menii in der Meniileiste beinhaltet Aktionen, die sich auf eine Simulation beziehen. Funktionen die
man oft bendtigt sind auch iiber die Toolbar zu erreichen.

o File

Close Simulation: Schliesst eine bereits ge6ffnete Simulation.

Save: Speichert eine verdnderte Simulation ab.

New Simulation: Erstellt eine neue Simulation, 6ffnet den Dialog 2.2.2

Open Simulation: Offnet eine Simulation, die in eine Datei abgespeichert wurde.
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— Save As: Speichert eine Simulation in einer Datei.
— Settings: Offnet den Dialog Einstellungen 2.2.2.
— FExit: Beendet JORGE

e Robot
— Add Robot: Fiigt einer bereits gedffneten Simulation ein Roboter hinzu. Fiir jeden Roboter

wird ein neuer RobotTab erstellt 2.1.3

— Remove Robot: Entfernt den zum ausgewihlten RobotTab gehdrenden Roboter aus der Simu-
lation.

— View Robot: Aktiviert den Modus: Roboter Ansehen 2.3.3
o Simulation

— World Settings: Offnet den Dialog: 2.2.2
— Prepare Simulation: Wechselt in den Modus Welt Konfigurieren Modus 2.3.2
— Start Simulation: Wechselt in den Modus Simulation 2.5.4

e Help

— Open Documentation: Offnet diese Dokumentation.
— About: Informationen iiber die Entwickler von JORGE.

2.1.2 Toolbar

Die Toolbar enthélt haufig gebrauchte Aktionen, die auch iiber die Meniileiste erreichbar sind. Die Schalt-
flaichen der Meniileiste sind nicht mit Text bezeichnet. Halten Sie die Maus ein paar Sekunden iiber die
Schaltflichen, damit eine Beschreibung angezeigt wird. Die sich jeweils entsprechenden Aktionen aus der
Meniileiste und der Toolbar besitzen das gleiche Icon.

2.1.3 RobotTab

Ein RobotTab reprasentiert einen Roboter. Die einzelnen Bestandteile werden in diesem Abschnitt be-
schrieben, und zwar in der Reihenfolge wie sie auch auf der Benutzeroberfliche von oben nach unten
auftreten.

2.1.3.1 Robot Control

Hier wird die Start Position (Current Position) des Roboters angezeigt. Die Start Position legt fest, von
wo der Roboter startet wenn Sie die Simulation starten. Nutzen Sie die Schaltfliche Replace Robot,
um den Roboter an den Ort zu verschieben, der durch das rote Kreuz markiert wird.

Manual Drive ermdoglicht es Thnen, den Roboter von Hand zu steuern. Folgende Tasten der Tastatur
konnen zur Navigation genutzt werden:

e R: Linker Motor vorwérts

e [: Rechter Motor vorwérts

D: Linker Motor stop

K: Rechter Motor stop
e F: Linker Motor riickwérts
e J: Rechter Motor riickwérts

Bemerkung: Diese Tastatureingaben sind nur méglich wenn sich der Mauszeiger innerhalb des 3D Window
(siehe 2.1.4) befindet.
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2.1.3.2 LCD Output

Das Roboter Programm kann hier Zahlen und Symbole anzeigen. LeJOS sieht vor, dass auf dem LCD Dis-
play auch Buchstaben ausgegeben werden konnen, dies wir von JORGE nicht unterstiitzt. Diese Anzeige
hat experimentellen Status, d.h. die Entwickler von JORGE koénnen nicht garantieren, dass die Ausgabe
korrekt ist.

2.1.3.3 Emulation

Uber die Schaltflichen Start, Pause und Stop kann im Simulations Modus (siehe Abschnitt 2.3.4) das
Roboter-Programm kontrolliert werden.

2.1.3.4 Robot Details

Jedem Roboter kann ein Name vergeben werden. Um den Namen dauerhaft zu &ndern, schliessen Sie
die Eingabe des Namens mit der Enter-Taste ab, der Angezeigte Name im Reiter des RoboTabs wird nun
aktualisiert.

Mit der Schaltfliche Load kann ein bereits kompiliertes und gelinktes Roboter-Programm in den
virtuellen Roboter geladen werden. Wenn Sie das Programm mit JORGE erstellt haben, tragt die zu
ladende Datei die Endung .emu. Wenn ein Programm geladen ist, wird dessen Dateiname im Textfeld
Program Binary angezeigt. Sie konnen ein bereits geladenes Programm auch ersetzen.

Im Modus Roboter Ansehen konne Sie die Farbe des Roboters dndern. Dazu klicken Sie auf die
Schaltflache Change und wéhlen im Dialog die gewiinschte Farbe aus.

Die Schaltfliche Robot Settings 6ffnet den Dialog Robot Settings (siehe Abschnitt 2.2.3) und die
Edit Program Source startet den Editor (Abschnitt 2.6).

2.1.3.5 Robot Log

Wenn das Roboter-Programm Instruktionen an den virtuellen Roboter schickt, werden die Details in
diesem Textfeld ausgegeben.

2.1.4 3D Window

Dieser Teil der Benutzeroberflache zeigt die virtuelle Welt an. Je nach Modus (siehe Kapitel 2.3) nimmt
die Maus und die Tastatur eine andere Funktion an.

2.1.4.1 Overlay

Hier sind Einzelheiten der Grafikausgabe angezeigt:

e Current FPS: Diese Zahl gibt an, wie oft der Inhalt des 3D Windows neu gezeichnet wird (pro
Sekunde).

e Average FPS: Die durchschnittliche Anzahl gezeichneter Frames pro Sekunde.
e Best FPS: Der Beste je erreichte Wert, seit Sie JORGE gestartet haben.

e Triangle Count: Die Anzahl Dreiecke aus der das angezeigte Bild aufgebaut ist.

2.1.5 Obstacle Toolbar

Die Obstacle Toolbar zeigt Hindernisse an, die in die Simulation eingefiigt werden kénnen. Wenn Sie auf
das entsprechende Symbol klicken, wird das Hindernisse an dem Ort eingefiigt, der mit dem roten Kreuz
markiert ist. Wie Sie selber Hindernisse zu JORGE hinzufiigen, ist im Kapitel 3.1 beschrieben.
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2.2 Dialoge

2.2.1 Einstellungen

Settings

Render Settings

Rendering Subsystem: Direct3D% Fendering SubSystem |

anti aliasing: Hone

Floating-poink mode: Fastest

Full Screen: Mo

Rendering Device: NYIDIA Quadro FX 3400
wSyne: o

wideo Mode: 1260 1024 @ 16-hit colaur

[choose An Option]: b
Environment Settings
These Settings are used by ths compiler of the Source Code Edtar.
Java-Compler (e.g. javar.exe):
Ledos-Directoryi
Loaded Sensor Plugins

Name Version | _Description Author
[ight Touch Sensor 0.1 A Touch Sensor  JORGE Team
Compass Sensor 0.1 4 Compass Sensor | JORGE Team
Left Touch Sensor 0.1 A Touch Sensor JORGE Team

Cancel

Abbildung 2.2: Einstellungen
Dieser Dialog fasst alle Einstellungen die JORGE betreffen zusammen.

2.2.1.1 Render Settings

Die Render Settings definieren das 3D Ausgabesystem, JORGE unterstiitzt derzeit nur DirectX 9.
Wenn Sie Schwierigkeiten mit der Anzeige haben, sollten Sie die Einstellungen fiir das Rendering Device
iiberpriifen: Dazu aktivieren Sie die entsprechende Zeile im Textfeld und wéahlen Ihre Grafikkarte in der
Liste aus(in Abbildung 2.2 ist die Liste mit [Choose An Option] angeschrieben).

2.2.2 World Settings

World Settings
r world
‘Watld Terrain C:hworkspaceljorgein
Gravity b3 o
" -9,50865
zZ 1]

Abbildung 2.3: Welt Einstellungen

Der Dialog World Settings fasst Einstellungen der virtuellen Welt zusammen. Mit der Option World
Terrain konnen Sie eine Datei angeben, die festlegt, wie die virtuelle Welt aussieht (welche Vorausset-
zungen erfiillt sein miissen, konnen Sie dem Abschnitt 3.2 entnehmen).

In den Textfeldern, die mit Gravity zusammengefasst werden, legen Sie die Richtung und die Be-
schleunigung (7z) der Erdanziehung fest. Abbildung 2.4 zeigt die Ausrichtung des Koordinatensystems.
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Bitte beachten Sie, dass Sie mit X,Y,Z einen Richtungsvektor beschreiben. Wenn also die Gravitation
senkrecht nach unten zeigen soll, muss die Y-Komponente negativ sein.

Abbildung 2.4: Koordinatensystem

2.2.3 Robot Settings

Robot Settings
— Robot Settings — Mokor Settings
Name Robot: 1134545105| Chaose Matar Mator 1 v
Source Files Redline 1
Break 1000
Min. Torque 0.25
Mazx, Torque 0.4
Binary Program ]
T r Wheel Settings :
Choose Wheel Wheel 1 [
eIl &8 — Connected Maotar | Motor 1 v
¥ 200 Mesh
z 1703 Mass 0.01
Gravity Mass 0.1 Break b.00t
% 0 Bouncyness 0
¥ o5 Friction 100
Z 0 Fis 1
Suspension Spring | 0.01
r Sensor Settings
] 0! Sensor 1 Right Touch Sensor v
Step oot Sensar 2 Campass Sensor v
Sensor 3 Left Touch Sensor v

Abbildung 2.5: Roboter Einstellungen

Das Fenster Robot Settings fasst alle Einstellungen eines Roboters zusammen. Sie werden in der
JORGE-Projektdatei abgespeichert, so dass eine Simulation jederzeit wieder hergestellt werden kann.

2.2.3.1 Robot Settings

e Name: Ein frei wiahlbarer Name mit dem Sie einen einzelnen Roboter benennen konnen. Der Name
wird im Reiter des RobotTabs angezeigt.
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Source Files: Hier kénnen Sie die Quelltexte, die zu einem Roboter-Programm gehoren, einem
Roboter zuordnen. Sie werden automatisch im Editor geéfinet werden, wenn Sie im RobotTab auf
die Schaltfliche Edit Program Source Kklicken.

Start Position: Beschreibt die Ausgangsposition des Roboters in der virtuellen Welt. Achten
Sie darauf, dass die gew&hlten Koordinaten verniinftige Werte annehmen, sonst verschwindet der
Roboter von der Bildfliche (die maximalen Werte sind abhéngig vom ausgewéhlten Terrain).

Gravity: Hier konnen Sie den Massenmittelpunkt und die physikalische Masse des Roboters fest-
legen.

— Mass: Das Gewicht des Roboters in Kilogramm.

0
— X.,Y und Z: Beschreibt den Massenmittelpunkt des Roboters. Die Koordinate 0 beschreibt
0

genau die Mitte des Robotermodells.

Suspension: Beschreibt die Federung der Roboter-Réder. Um den Rechenaufwand nicht unnétig
zu erhohen, haben alle Réder die gleichen Feder-Eigenschaften.

— Spring: Die Federkonstate der Federung (eine kleine Zahl beschreibt eine weiche Federung).

— Damping: Dies ist ein Mass fiir die Dampfung der Federung (wie lange es geht bis die Schwin-
gung aufhort).

— Step: Eine Konstante zur Berechnung der Federung.

Restore Defaults: Setzt die Einstellungen auf die Vorgabe zurtick.

2.2.3.2 DMotor Settings

Choose Motor: Hier konnen Sie den Motor auswéhlen, dessen Einstellungen Sie verdndern méch-
ten.

Redline: Die maximale Drehzahl des Motors.

Break: Die Bremskraft des Motors.

Min. Torque: Das minimale Drehmoment des Motors.
Max. Torque: Das maximale Drehmoment des Motors.

Restore Defaults: Setzt die Einstellungen auf die Vorgabe zuriick.

2.2.3.3 Wheel Settings

Choose Wheel: Hier konnen Sie das Rad auswéhlen, dessen Einstellungen Sie verdndern mdchten.
Connected Motor: Bestimmt welcher Motor dieses Rad antreibt.

Mesh: Diese Option ist deaktiviert, mit ihr konnte ein eigenes 3D Modell fiir das Rad gew&hlt
werden.

Mass: Die Masse des Rades in Kilogramm.

Power: Ist ein Mass fiir die Kraftiibertragung vom Motor zum Rad, und entspricht einer Flieh-
kraftkupplung.

Break: Wie stark die Rédder von der Achse gebremst werden kénnen.

Bouncyness: Ein Mass fiir den Luftdruck im Rad oder wie fest der Roboter hiipft.
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e Friction: Die ist ein Mass fiir die Reibung die zwischen dem Boden und den Rédern entsteht.

e Fds: Steht fiir “Force Dependent Slips”, also wie fest die Rédder bei hohen Kréften zum Rutschen
neigen.

e Restore Defaults: Setzt die Einstellungen auf die Vorgabe zuriick.

2.2.3.4 Sensor Settings

Hier definieren Sie welche Sensoren an den Roboter angeschlossen sind. JORGE kann dank Plugins mit
Sensoren erweitert werden (siehe Abschnitt 3.3). Da der RCX nur drei Sensor-Eingénge besitzt, miissen
Sie hier festlegen, welche Sensoren eingesetzt werden.

e Sensor 1: LeJOS: Sensor.S1
e Sensor 2: LeJOS: Sensor.S2
e Sensor 3: LeJOS: Sensor.S3

2.2.4 Editor

[STsource Code Editor EJ@

Eie Edit View Extra Window Help

- ) M

Compile Link Upload Open Lelos Api

HeloRabot

public class HelloRobot [al|
I}
public static void main{String args[]) threws Exception
~ {
Motor.h.forvard() ;
Motor.C.forward(} ;
Thread.sleep(2000) ;

Motor.C.stop()
Thread.sleep(2000) ;

Motor.C.stop() ;
Motor.h.ztop()

Motor.d.backward() :
Motor.C.forward() ;

Motor.h.stop():
Motor.C.stop();

¥
<[ I i

Setting Environmet: JAVAC=C:\JjZsdkl.4.2 09\bin\javac.exe
getting Environmet: LEJOS HOME=D:\lejos

Compile Command: D:%lejos\bin\lejosc.exre -target 1.1 C:\javal\He
C:\java\HelleRobot. java:16: ;' expected

~

1l error
== Dong ==

] 0 2

Abbildung 2.6: Editor

Mit dem Editor kénnen Programme fiir die Roboter erstellt werden. Der Editor bietet sehr viele Funk-
tionen die Sie auch in jedem anderen Texteditor antreffen. Daher werden hier nur die Eigenheiten dieses
Editors beschrieben:

e Compile: Kompiliert den aktuellen Quelltext (aktiver Reiter im Editor) und alle Klassen, die
referenziert werden. Wenn Sie den Quelltext selber in einer Konsole kompilieren wollen, kénnen Sie
die notigen Befehle dem Ausgabefenster entnehmen.

e Link: Der Java-Compiler erstellt fiir jede Klasse eine .class Datei. Diese Dateien miissen zu einer
Datei (mit der Endung .emu) zusammengefligt werden, damit man sie auf den Roboter laden kann.
Beim Linken werden ausserdem die eingesetzten LeJOS Klassen zur resultierenden Datei hinzuge-
fligt. Wenn Ihr Programm aus mehreren Java-Dateien besteht, miissen Sie im Editor diejenige Datei
aktivieren, welche die main Methode enthélt, damit der Linker-Vorgang erfolgreich sein kann.
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e Upload: Ladt das gelinkte Programm in den Roboter. Wie beim linken, muss im Editor die Da-
tei ausgewéahlt sein, welche die main Methode enthélt. Programme kénnen nur im Modus Welt
Konfigurieren in den Roboter geladen werden.

e Open LeJos Api: Offnet das LeJOS API (Java Dokumentation) in einem externen Browser.

2.3 Modi

JORGE unterscheidet vier verschiedene Modi, die in diesem Abschnitt erklért werden. Die Toolbar zeigt
an, in welchem Modus Sie sich gerade befinden.

2.3.1 Modus: Simulation geschlossen

i

Abbildung 2.7: Simulation Geschlossen

Wenn Sie JORGE starten, ist JORGE solange in diesem Modus, bis Sie eine Simulation durch die ent-
sprechende Aktion im Meni File erstellen oder 6ffnen. Wenn Sie eine gedffnete Simulation iiber das Menii
File schliessen gelangen Sie wieder in diesen Zustand.

2.3.2 Modus: Welt Konfigurieren

t=12GO

Abbildung 2.8: Welt Konfigurieren

Sobald eine Simulation gedffnet wird, wechselt JORGE in diesen Modus. Hier geht es darum, dass Sie
die Roboter fiir die Simulation vorbereiten, d.h. Sie haben die Moglichkeit Roboter und Hindernisse in
die Welt einzufiigen und die gewiinschten Einstellungen vorzunehmen. In diesem Modus stehen folgende
Aktionen zur Verfligung:

e Die 3D Welt erkunden, siche Abschnitt 1.3

e Hindernisse einfiigen, siehe Abschnitt 1.3.1

e Roboter einfiigen, siche Abschnitt 1.3.2

e Roboter konfigurieren, siche Abschnitt 2.1.3 und 2.2.3

e Den Roboter manuell steuern, siche Abschnitt 2.1.3.1

e Bestehendes Roboter Programm laden, siehe Abschnitt 1.4
e Roboter Programm erstellen, siehe Abschnitt 1.5.1

e In den Roboter Ansehen Modus wechseln

e In den Simulations Modus wechseln
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2.3.3 Modus: Roboter Ansehen

Abbildung 2.9: Roboter Ansehen

In diesem Modus konnen Sie den Roboter ansehen und dessen Farbe verdndern. Sie konnen

e die Farbe des Roboters dndern, siche Abschnitt 2.1.3.4.
e den Roboter ansehen, siche Abschnitt 1.6

e zuriick in den Modus Welt Konfigurieren wechseln.

2.3.4 Modus: Simulation

Abbildung 2.10: Simulation

Beim Wechsel in diesen Modus werden alle Roboter-Programme gestartet. Sie knnen:
e die Kamera bewegen, wie in Abschnitt 1.3 beschrieben.
e Roboter stoppen, starten oder pausieren, sieche Abschnitt 2.1.3.3

e zuriick in den Modus Welt Konfigurieren wechseln.
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Kapitel 3

JORGE Erweitern

3.1 Neue Hindernisse Erstellen

Es ist moglich eigene Hindernisse zu definieren, und sie zu JORGE hinzuzufiigen. Dazu miissen Sie im
Unterverzeichnis <JORGE Installations-Ordner>/media/obstacles/ vier neue Dateien anlegen (Ersetzen
Sie <name> mit einem Wort Threr Wahl):

o <name>.xml definiert die Masse sowie die Form der Bounding-Box, welche benutzt werden soll:
box oder sphere. boxr und sphere sind dynamische Hindernisse, die in der 3D Szene verschoben
werden konnen. Es kénnen auch Hindernisse als static definiert werden. Das bedeutet, dass keine
Bounding-Box sondern jedes einzelne Polygon kollidiert. Dabei ist zu beachten, dass die Position
eines static Hindernisses unverdnderbar ist.

<?xml version="1.0" encoding="utf-8"7>

<obstacle xmlns="http://jorge.hta-bi.ch/jorgeobstacle"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemalocation="http://jorge.hta-bi.ch/jorgeobstacle

file:./jorge-obstacle.xsd">

<mass>100</mass>
<type>box</type>

</obstacle>

e .<name>.mesh die Daten des 3D Modells: Diese Datei muss mit einem 3D Modellierer erstellt
werden. Eine gute Anleitung finden Sie

o <name>.material legt die Oberflachen Textur fest, ein Beispiel:

material Ac3d/Crate/Mat001_Tex00

{
technique
{
pass
{
ambient 1 1 1 1
diffuse 1 1 1 1
texture_unit
{
texture crate.png
3
3
}
b
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Eine ausfiihrliche Anleitung finden Sie auf der OGRE http://www.ogre3d.org/docs/manual/
manual_15.html Homepage.

e <name>.gif Eine Bilddatei (die Formate bmp, gif, xbm und xpm werden unterstiitzt), die wenn
moglich 80x80 Pixel gross ist und als Vorschau auf der Benutzeroberfliche in der ObstacleToolbar
angezeigt wird.

3.2 Neues Terrain Erstellen

P Freeworld3D v2.0 CEX
Fie Edt iew Teman Toos Windows Hep

HeP2E9e kb s doa [+|2 a ~|[@ B | e Tenain & Lighting

o 0(e e mxz 4 b Speed 20| Height

n
Scene Entities
Cached Meshes

# [ Scene Meshes

1% Scere Explorer [ & Settings |

15 oupat|

Fleary Ediing Ternain Fps 68 | Camera: (186,34, 1531, 56557 ) Mouse: (20469, 811, 581.27)

Abbildung 3.1: Screenshot Freeworld3D

Das Terrain kann iiber mehrere Wege erstellt werden. In diesem Abschnitt werden allgemeine Infor-
mationen zur Erstellung eines Terrains gegeben.

Das Rendering eines Terrains wird in OGRE von der Klasse TerrainSceneManager iibernommen. Fiir
die korrekte Interpretation eines Terrains sind folgende Dateien notwendig:

e Heightmap - ist ein Graustufen-Bild, in welchem jedes Pixel einen Hohenwert représentiert. Der
Farbwert 0 steht fiir den tiefsten Punkt, der Farbwert 255 fiir den H6chsten.

e Terrain Textur - bildet das Terrain von oben ab.
e Detail Terrain Textur - wird verwendet, wenn der Betrachter das Terrain von nahem betrachtet.

e *.cfg - OGRE spezifisch. Triagt die Daten zusammen und enthélt zusétzliche Informationen wie die
Bemessung des Terrains oder die maximale Hohe im Koordinatensystem von OGRE.

Weitere Informationen, und die genauen Angaben zur *.cfg Datei finden Sie unter Terrain howto http:
//www.ogre3d.org/wiki/index.php/Terrain_Scene_Manager.
Abfolge der Schritte fiir die Erstellung eines Terrains:

1. Erstellung der Heightmap mit Hilfe eines Tools wie Freeworld3D oder Terragen
2. Texture mit Hilfe der oben genannten Tools dariiber legen

3. Export der Heightmap in eine *.bmp oder *.raw Datei

4. Export der Terrain Textur und der Detail Terrain Textur

5

. Erstellung der *.cfg Datei, eine Vorlage kann im Ordner <JORGE Installations-Ordner> /media/config
gefunden werden
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3.3 Sensoren hinzufiigen

JORGE wurde so konzipiert, dass andere Entwickler neue Sensoren erstellen kénnen, und Sie diese Sen-
soren zu JORGE hinzufiigen kénnen. Damit JORGE diese neuen Sensoren ladt, miissen Sie die Dateien,
die Sie vom Entwickler (oder von dessen Website) erhalten, in das Verzeichnis <JORGE Installations-
Verzeichnis>/media/plugins/Release/ kopieren und JORGE gegebenenfalls neu laden. Der Dialog Ein-
stellungen (siehe 2.2.1) zeigt alle geladenen Sensoren an.
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Anhang A

Java Installation

Eine Java Installation ist nicht nétig, wenn Sie vorkompilierte Roboter-Programme ausfiihren wollen.
Wenn Sie jedoch Programme selber schreiben, ist ein Java SDK (Software Development Kit) unerlésslich.
Java kann kostenlos von http://java.sun.com heruntergeladen werden. Dort finden Sie auch ausfiihrliche
Installationsanleitungen.

Merken Sie sich bei der Installation das Verzeichnis, in welches Sie Java installieren. Dieses Verzeichnis
hat normalerweise einen Unterordner bin/, der das Programm javac.exe enthélt.

Fiir dieses Handbuch wurden folgende Konfiguration verwendet:

e Java Version: j2sdk1.4.2_ 09

e Installationsverzeichnis: C'|

Weitere Informationen: http://java.sun.com/j2se/1.4.2 /install-windows.htmlhttp://java.sun. com/j2se/
1.4.2/install-windows.html
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Anhang B

LeJOS Installation

LeJOS kann von hitp://lejos.sf.net heruntergeladen werden. Fiir LeJOS gibt es kein Installations Pro-
gramm: Es reicht aus, die Datei (lejos_ win82 2 1 0.zip) in ein Verzeichnis Threr Wahl zu entpacken.
Merken Sie sich wo Sie LeJOS entpackt haben, da Sie dieses Verzeichnis JORGE angeben miissen wenn
Sie Programme kompilieren wollen.

Fiir dieses Handbuch wurden folgende Konfiguration verwendet:

e LeJOS Version: 2.1.0 (Windows Version)
e Installationsverzeichnis: D:|lejos |

Anmerkung: LeJOS setzt eine Java Installation voraus.
Weitere Informationen: http://lejos.sourceforge.net /installwindows.htmlhttp: //lejos.sourceforge.
net/installwindows.html
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